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INSTRUCTIONS
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Thank you for purchasing the JVC VN-C1U. 
To gain maximum benefit from this product, read this 
instruction manual carefully before use and retain it for future 
reference.
The serial number is very important for maintaining quality of 
your product. At the time of purchase, check to see that the 
serial number is correctly printed on the top of the unit and 
that the serial numbers on the unit and warranty match.

This instruction manual is printed on 
recycled paper.

For Customer Use:
Enter below the Model No. and Serial 
No. which are located on the rear of the 
cabinet. Retain this information for future 
reference.

 Model No.

 Serial No. 



1. Read all of these instructions.
2. Save these instructions for later use.

  3. All warnings on the product and in the operating instructions should
be adhered to.

4. Unplug this appliance system from the wall outlet before cleaning.
Do not use liquid cleaners or aerosol cleaners. Use a damp cloth
for cleaning.

5. Do not use attachments not recommended by the appliance manu-
facturer as they may cause hazards.

6. Do not use this appliance near water – for example, near a bath-
tub, washbowl, kitchen sink, or laundry tub, in a wet basement, or
near a swimming pool, etc.

7. Do not place this appliance on an unstable
cart, stand, or table. The appliance may fall,
causing serious injury to a child or adult, and
serious damage to the appliance.
Use only with a cart or stand recommended
by the manufacturer, or sold with the appli-
ance. Wall or shelf mounting should follow
the manufacturer's instructions, and should
use a mounting kit approved by the manu-
facturer.
An appliance and cart combination should be moved with care.
Quick stops, excessive force, and uneven surfaces may cause the
appliance and cart combination to overturn.

8. Slots and openings in the cabinet and the back or bottom are pro-
vided for ventilation, and to insure reliable operation of the appli-
ance and to protect it from overheating, these openings must not
be blocked or covered. The openings should never be blocked by
placing the appliance on a bed, sofa, rug, or other similar surface.
This appliance should never be placed near or over a radiator or
heat register. This appliance should not be placed in a built-in in-
stallation such as a bookcase unless proper ventilation is provided.

9. This appliance should be operated only from the type of power
source indicated on the marking label. If you are not sure of the
type of power supplied to your home, consult your dealer or local
power company. For appliance designed to operate from battery
power, refer to the operating instructions.

10. This appliance system is equipped with a 3-wire grounding type
plug (a plug having a third (grounding) pin). This plug will only fit
into a grounding-type power outlet. This is a safety feature. If you
are unable to insert the plug into the outlet, contact your electri-
cian to replace your obsolete outlet. Do not defeat the safety pur-
pose of the grounding plug.

IMPORTANT SAFEGUARDS

PORTABLE CART WARNING
(symbol provided by RETAC)

S3126A



Printed in Japan

11. For added protection for this product during a lightning storm, or
when it is left unattended and unused for long periods of time,
unplug it form the wall outlet and disconnect the antenna or cable
system. This will prevent damage to the product due to lightning
and power-line surges.

12. Do not allow anything to rest on the power cord. Do not locate this
appliance where the cord will be abused by persons walking on it.

13. Follow all warnings and instructions marked on the appliance.
14. Do not overload wall outlets and extension cords as this can result

in fire or electric shock.
15. Never push objects of any kind into this appliance through cabinet

slots as they may touch dangerous voltage points or short out parts
that could result in a fire or electric shock. Never spill liquid of any
kind on the appliance.

16. Do not attempt to service this appliance yourself as opening or
removing covers may expose you to dangerous voltage or other
hazards. Refer all servicing to qualified service personnel.

17. Unplug this appliance from the wall outlet and refer servicing to
qualified service personnel under the following conditions:
a. When the power cord or plug is damaged or frayed.
b. If liquid has been spilled into the appliance.
c. If the appliance has been exposed to rain or water.
d. If the appliance does not operate normally by following the op-

erating instructions. Adjust only those controls that are covered
by the operating instructions as improper adjustment of other
controls may result in damage and will often require extensive
work by a qualified technician to restore the appliance to nor-
mal operation.

e. If the appliance has been dropped or the cabinet has been dam-
aged.

f. When the appliance exhibits a distinct change in performance –
this indicates a need for service.

18. When replacement parts are required, be sure the service techni-
cian has used replacement parts specified by the manufacturer that
have the same characteristics as the original part. Unauthorized
substitutions may result in fire, electric shock, or other hazards.

19. Upon completion of any service or repairs to this appliance, ask
the service technician to perform routine safety checks to deter-
mine that the appliance is in safe operating condition.

VICTOR COMPANY OF JAPAN, LIMITED



WARNING:
TO PREVENT FIRE OR SHOCK HAZARD, DO
NOT EXPOSE THIS UNIT TO RAIN OR MOIS-
TURE.

AVERTISSEMENT:
POUR EVITER LES RISQUES D’INCENDIE
OU D’ELECTROCUTION, NE PAS EXPOSER
L’APPAREIL A L’HUMIDITE OU A LA PLUIE.

Due to design modification, data given in this instruction book
are subject to possible change without prior notice.

Pour cause de changements de conception, les données
indiquées dans ce mode d'emploi peuvent être sujettes à des
modifications sans préavis.

CAUTION
RISK OF ELECTRIC SHOCK

DO NOT OPEN

CAUTION:    TO REDUCE THE RISK OF ELECTRIC SHOCK.
DO NOT REMOVE COVER (OR BACK).

NO USER-SERVICEABLE PARTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

The lightning flash with arrowhead symbol, within an equi-
lateral triangle, is intended to alert the user to the pres-
ence of uninsulated “dangerous voltage” within the prod-
uct’s enclosure that may be of sufficient magnitude to con-
stitute a risk of electric shock to persons.

The exclamation point within an equilateral triangle is in-
tended to alert the user to the presence of important oper-
ating and maintenance (servicing) instructions in the lit-
erature accompanying the appliance.

for USA

i



Information for USA
This equipment has been tested and found to comply with the
limits for a class A digital device, pursuant to Part 15 of the FCC
Rules.
Changes or modifications not approved by JVC could void the
user’s authority to operate the equipment.

INFORMATION (FOR CANADA)
RENSEIGNEMENT (POUR CANADA)

This Class A digital apparatus meats all requirements of  the
Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les
exigances du Réglement sur le matérial brouilleur du Canada.

CONTENTS
Warnings cautions and Others ................................................................................. i

Package Contens ................................................................................................... 1

Operational Environment ........................................................................................ 1

About Upgrades ..................................................................................................... 2

Installation and Setup ............................................................................................. 3

   Before starting installation and setup ................................................................. 3

   Names of VN-C1U parts ...................................................................................... 3

   Installation and set up ......................................................................................... 3

Operating the Controller Software ........................................................................ 12

   Establishing connection and changing the connection point .......................... 12

   Controller 1,2 ..................................................................................................... 12

   Creating a new connection point ...................................................................... 13

   Deleting a connection point .............................................................................. 14

   Changing the display size and inventing the image ........................................ 15

   Adjusting the image quality ............................................................................... 15

   Image sensor setting ......................................................................................... 16

   Specifying the transmitted number of frames ................................................... 17

   Still image save feature ..................................................................................... 18

What to do when ................................................................................................... 19

Specifications ....................................................................................................... 22

ii



1

Package Contents

Operational Environment

This product is packaged with the following items. Contact your dealer of purchase for any missing 
items.

VN-C1U main unit

VN-C1U controller CD-ROM

Ferrite core

Instruction manual (this document)

BRACKET

BASE

SCREW

The following environment is necessary for the operation of VN-C1U.

PC operating with Microsoft Windows 95,98 or NT

 CPU : Pentium 133MHz or equivalent or higher
(200MHz or higher recommended)

 Memory : 32MB or more (64MB or more recommended)
 Hard disk space : 20MB or more
 Display and video card : 640 X 480 pixels or higher; high color

(1024 X 768 pixels or higher; true color recommended)
 10BASE-T :  LAN board, connector cables

LAN environment
 10BASE-T network cross-connected with HUB, etc. of IEEE802.3 standard.
 It is also possible to  connect your PC with VN-C1U directly (1:1) using a crossing cable 
(please check since some LAN boards do not allow use of cross cables).
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Precautionary Notes

Avoid installing in the following locations:
 Where the unit is exposed to rain or water
 Where the ambient temperature exceeds the range of 0∞C ~ +40∞C (recommended)
 Where there is vibration
 Dusty areas or areas with oil or gas

The sensitivity will automatically increase when using this unit in a dark location with the 
AGC on (Full Auto on). At this time the ??screen may appear rough??; however this is not a 
malfunction.

When using Full Auto on for the white balance of this unit, the tint may appear slightly 
different from that of the actual color due to the principle of the automatic  white balance 
tracking circuit; however, this is not a malfunction.

When shooting a highly bright object such as lamps, etc. white tails may appear above and 
below the object on the screen. This is an elemental characteristic seen when shooting solid 
objects referred to as the smearing effect, and is not a malfunction.

About Upgrades

Upgrades of the software (VN-C1U) can obtained via the Internet. The upgrade software can be 
downloaded from the following homepage: 
http://www.jvc-victor.co.jp
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Installation and Setup 

Before starting installation and setup

Since a setup of one IP address is necessary for each VN-C1U, follow the procedure given below to 
setup each unit (the installation can be made at the same time if the power is left off.

1. Install VN-C1U
When installing in a location where it is difficult to turn the power on and off, install after 
completing steps 2 through 5.

2. Connect VN-C1U to a network
(turn the power of VN-C1U on)

3. Set the IP address of VN-C1U
Always contact the network management for the IP address of VN-C1U and use only that which 
is assigned or authorized.For setup of a second unit and following, reboot the PC and return to 
step 2.

4. Enable the set IP address of VN-C1U
(Turn the power of VN-C1U off once, then turn the power back on)

5. Register the connecting point
Register the IP address information of VN-C1U to the user PC.

Names of VN-C1U parts

10BASE-T port

DC input jack

Lens cover

Lens block

Front Rear Top
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Installation and Setup

1. Installation
Prepare the accessory parts and begin installation.
Make the power and network connections after first finishing this installation.

  Note
Make the installation at a location having plenty of structural strength so 
accidents such as dropping or collapsing can be prevented.
Or connect with a wire chain or similar item to a sturdy location.

(1) Install the mount onto the fixture.
(2) Install the fixture onto the main unit.

Saftey wire for fall prevention
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2. Connecting to a network
Turn on the power of only one VN-C1U.
Connecting VN-C1U to a network and turning on the power will connect the unit to a network with the 
following IP address.

  Note

Factory set IP address  :   192.168.  1.  2

All VN-C1U at the time of shipment have the same IP address. Correct 
access cannot be obtained when turning the power of multiple units on at the 
same time due to overlap of ID addresses. Always turn on the power of one 
unit at a time and proceed with the following VN-C1U IP address setup.
In the case where doubling of IP addresses occur, correct access may not be 
achieved  unless waiting for at least 10 minutes after making correction, or 
turning off all network devices then turning them back on.

To power outlet

When connecting to a HUB, use a straight cable. 
When connecting directly to a PC, use a crossing cable.

Special adapter

Shielded
modular cable

To retain electromagnetic compatibillity,use the provided
ferrite core when connecting to VN-C1U.

Install the ferrite core within 50mm
 of VN-C1U-side connector.

Ferrite core

Wound 3x
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3-1 Changing the IP address of the PC making the setting
From the [Start] button proceed to [Setup] - [Control Panel] - [Network] to display the network 
setup panel.

3. VN-C1U IP address setup

(1) Select TCP/IP and click Properties.

(4) After clicking OK, reboot the PC.

(2) Before making changes, take note 
of the original IP address. 
After taking note of the IP address, 
change it to:192.168.  1.  1

(3) Set appropriate values for the Sub-
net Mask during the setting. If 
unknown, contact your network 
management.
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3-2 Installing the software
Insert the VN-C1U controller CD-ROM into the CD-ROM drive.
The setup program is located in the \JVC folder of the CD-ROM.
Execute \JVC\Setup.exe, then follow the on-screen guidance to setup the software.
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3-3 VN-C1U IP address setup
The V.NETWORKS setup tool is located in the \JVC\setup folder of the CD-ROM.
Execute \JVC\setup\vsetup.exe (execute directly from the CD-ROM).

 For an explanation of the password button, see the following page.

Set appropriate values for the sub-net 
mask during the setting. If unknown, 
contact your network management.

Input the IP address assigned or 
authorized by the network management.
(The illustration shows an example 

using 172.16.  1. 50.)

Depending on the installation condition, 
select either Normal installation (JVC 
mark on VN-C1U is upright) or Inverted 
installation (if uncertain due to a special 
installation, select Normal)

Setting to reduce flickering under 
fluorescent lighting.
Specify 50Hz or 60Hz, depending on 

the power supply frequency of the 
installed location.

The Camera ID is equivalent to the ID 
code of the VN-C1U main unit. Input 
using alphanumerics. This setting does 
not directly concern users.
Normally this ID is set by numbering up.

Input the IP address of VN-C1U being 
set.
Factory set IP address is 192.168.  1.  2.
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Password protection feature
VN-C1U is equipped with an access protection feature using a password to regulate 
connecting PCs (users).
This password can be set or canceled using the V.NETWORKS setup tool.

Note
Never forget the password since the password setting can only be changed 
and canceled when the current password matches.

The following screen will appear when clicking the Password button of the V.NETWORKS 
setup tool.

The following Password Request screen will appear for VN-C1U set with password protection. 
VN-C1U setup cannot be made unless the password matches.

Enter the current password. When 
setting the password protection for the 
first time, leave this space blank.
Entered characters will be displayed as 
'*'.

Enter the same password when setting 
the password protection or when 
changing the password. To cancel the 
password protection, leave the spaces 
blank.
Entered characters will be displayed as 
'*'.

Setting will be updated when clicking 
Yes.
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Notes
The V.NETWORKS setup tool will only operate on PC's installed using the 
procedure described on page 7 (execution of setup.exe). The setup tool will 
not operate properly if setup.exe has not been executed. For PC's that have 
executed setup.exe can also operate the setup tool by copying the setup 
folder to the hard disk, etc. The V.NETWORKS setup tool is a software that is 
used only when setting up. In case the  folder is copied, we asked that it be 
deleted after completion of the setup, unless the PC requires the folder for a 
special reason.
For setup of a second unit and following, reboot the PC and return to step 2 
(page 5). Proceed when all VN-C1U settings are completed.

3-4 Restoring the IP address of the work PC
In the same manner as 3-1, start from the [Start] button then go [Setup]-[Control Panel]-

[Network], then correct/restore the TCP/IP properties of the network settings to  the  original IP 
address which was noted.
After correction, reboot the PC according to the on-screen instructions.

4. Enabling the set IP address
Turn the power of VN-C1U off, then turn the power back on.

The IP address changed using the setup tool is enabled for the first time when the power of VN-
C1U is turned off, then turned backed on.

(The unit will continue operation using the IP address before the change until the power is turned 
off.)

[ IP ADDRESS SEARCH FUNCTION]
By pressing the "Search" button, you can view the IP address of  V.NETWORKS now connected to 
the network.Pressing the search button brings up the [search screen] window. 
By pressing "Search" on the [search screen] window, a list 
of IP address of all V.NETWORKS is displayed.  Using TIME-OUT,  
you can set the time for search from 0 to 30 seconds.
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5. Registering the connection point
Start up the VN-C1U controller (VN-C1U connection software: vn-c1u.exe).
Execute [New] from the [File] menu to set the connection point.

To make correction after completing registration, first delete all settings then re-register.

To copy connection point settings to another PC
The VN-C1U connection point information is created as a dat file (extension: .dat) in the 
folder where the connection software was installed. 
Connection point information can easily be copied to another PC by copying the dat file. 

Advice

Enter the VN-C1U IP address of the 
connection point and the setting name 
(the illustration shows an example using 
172. 16.  1. 50).
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Operating the Controller Software

Establishing Connection and changing the connection point

For the installation procedure, see page 7 Installing the software. When the VN-C1U controller: vn-
c1u.exe is started up, a splash logo will appear, followed by the following screen.

To make the connection, select the 
registered connection point.

Controller 1

The VN-C1U screen appears immediately when connected.
The name of the currently connected VN-C1U is displayed.

Currently connected VN-C1UCurrently connected VN-C1UCurrently connected VN-C1U
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Controller 2

Placing the mouse pointer on the VN-
C1U and waiting momentarily will 
display the VN-C1U name in a form of a 
balloon display. The entire VN-C1U 
name will appear in the balloon display, 
even for long names.

The VN-C1U controller is equipped 
with a feature to save 1 frame of the 
images from the  connected VN-
C1U as a still image. The currently 
displayed VN-C1U image can be 
saved by clicking this button. For 
details, see page 20 Still image 
save feature

Creating a new connection point

See page 11 Registering a connection point



14

Deleting a connection point

Note
Connection point settings cannot be restored once they are deleted. Take 
special caution when making deletions.

Select [Delete] from the [File] menu.

Select the connection point, then click 
OK.

Check the content to delete, then click 
OK.
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Changing the display size and inverting the image

Adjusting the image quality

For details on the image sensor settings, see the following page.

Select the image size.
The displayed image can also be inverted.

Used to set the unit to the factory settings. 
Click OK to enable settings.

To enable settings after making changes, 
click  OK.

Select the [View] menu.

Select [Quality] from the [Setting] 
menu.  

The compression ratio is inversely 
proportional to the image quality.
The number of frames of the image 
displayed per second is proportional to 
the compression ratio.

Compression ratio (Low)-(Mid)-(High)
Image quality (High)-(Mid)-(Low)
Number of frames (Min)-(Mid)-(Max)
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Image sensor settings

The VN-C1U uses a CMOS image sensor as an imaging device.
It is possible to adjust the image by changing the image sensor settings.

Saturation Color saturation adjustment

WB-Blue Blue balance adjustment for the white balance

WB-Red Red balance adjustment for the white balance

Full Auto Used to switch between automatic and manual

Gain Internal amp gain adjustment

Exposure Exposure time adjustment

Contrast Contrast adjustment

Brightness Brightness adjustment

(Saturation increases when the value is increased and
   the saturation decreases when the value is decreased.)

(The color of blue will deepen when the value is increased 
  and the color weakens when the value is decreased.)

(When the check is removed, the operation settings for the 
  following 5 items will switch to manual.)

(Operated only when there is shortage of light)

(The exposure time increases when the value is increased 
 and the time decreases when the value is decreased.)

Item                        Effect
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Specifying the transmitted number of frames

Notes
The actual number of frames per second transmitted or displayed is 
influenced by the performance of the PC, image compression ration and LAN 
environment. To prevent obstruction in communication to other users, please 
lower the frame rate when a LAN is shared by multiple processes (especially 
when in an environment where there is a constant heavy load on the 
network).

Select [Frame rate] from the [Setting] 
menu.

Set the upper limit of the transmitted 
number of frames per second for the 
image sent from VN-C1U.
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Still image save feature

With the VN-C1U controller, a desired snapshot of the displayed image can be taken and saved as a 
JPEG image file.

Click the Snapshot button.

Specify the location to save.

Enter the file name.

Click Save to save the file.

A file name is attached only when 
selecting [Save As] from the [Save] 
menu of each snapshot display, where 
followed by a Save dialog box.

The snapshot display will appear.
Up to 16 snapshots can be displayed. 
When 16 snapshots are displayed, the 
camera mark will disappear. A beeping 
sound will be heard when clicking the 
Snapshot button at this time.

Note
Saved images can be viewed using a conventional viewer software. However, 
inverted images will not be displayed inverted. Furthermore, the reproduced 
tint may vary with the VN-C1U controller screen.
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You forgot or misplaced the VN-
C1U IP address changed using 
the V.NETWORKS setup tool.

Record of contents changed using the 
V.NETWORKS setup tool is saved in a file 
named vsetup.log located in the root direc-
tory using the following format:

IP address before change, ID before 
change
IP address  after change, ID after change
Date/time (day/month/year/h:m)

The unit will be treated as a repair if the IP 
address remains unclear even after refer-
encing the vsetup.log file. Please contact 
your dealer of purchase.

You set the password protection 
feature but forgot the password.

Cancellation of the password protection is 
treated as a repair. Please contact your 
dealer of purchase.
For security reasons, a proper identification 
may be requested.

It takes awhile to cancel when 
the "Connecting..." message is 
displayed.

Canceling of  operation is purposely set so 
that it cannot be made for several seconds 
when the unit is connecting.

What to do when:
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The image is out of focus. The focus can be adjusted by following the 
procedure given below.

1.Remove the lens cover.
2.Loosen the screw locking the lens 

block.
Note:For your safety, turn off the power 

before loosening the screw.

3.Start up the VN-C1U controller so that 
the VN-C1U image can be viewed.

4.Rotate the lens block slowly until the 
image is in focus.

5.Securely tighten the lock screw.
6.Close the lens cover .

Lens block
Lock screw
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When there is a problem with the 
tint.

The image size changed auto-
matically.

·Check the color adjustments of the display 
and video card.

The tint may vary slightly depending on the display 
monitor and the video card of the PC. The tint may 
be improved by adjusting the color setting of the 
monitor. Depending on the video card, the color 
may also be adjusted by selecting Display Proper-
ties (right click on the desktop).

·Switch to True Color (24 bit)

Reproduction of natural colors becomes difficult 
when the PC is set to High Color (16 bit) or lower. 
It is recommended that the PC is set to True Color.

·Adjust WB-Red and WB-Blue

It is also possible to adjust the tint using the WB-
Red and WB-Blue in the Image quality adjustment 
screen.

·Turn Full Auto off then turn it back on

When shooting scenes with different light sources 
(for example alternately switching between an 
outdoor scene under sunlight and indoor scene 
under fluorescent lighting), the automatic white 
balance tracking may take some time to operate. 
In this case, check off Full Auto and check it 
again for immediate operation of the automatic 
white balance tracking.

When the same VN-C1U is connected to 
multiple PCs, the PC used to set or control 
VN-C1U last has priority over the remaining 
PCs.
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Specifications

LAN specification : IEEE802.3 standard
Communication protocol : UDP/IP

Image sensor : 1/3 inch, 300,000 pixels CMOS image sensor
M.O.D. : 1.0 m

Output image size : 640 X 480, 320 X 240, 160 X 120 pixels
Line voltage : DC 5 V

Demand current : 0.6 A (max)
Operating temperature : 0 to 40˚C

Mass :  Approx. 230 

Dimensions (Unit: mm)

122

82
97
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